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Legal information 
Use of application examples 

Application examples illustrate the solution of automation tasks through an interaction of several 
components in the form of text, graphics and/or software modules. The application examples are 
a free service by Siemens AG and/or a subsidiary of Siemens AG ("Siemens"). They are 
non-binding and make no claim to completeness or functionality regarding configuration and 
equipment. The application examples merely offer help with typical tasks; they do not constitute 
customer-specific solutions. You yourself are responsible for the proper and safe operation of the 
products in accordance with applicable regulations and must also check the function of the 
respective application example and customize it for your system. 

Siemens grants you the non-exclusive, non-sublicensable and non-transferable right to have the 
application examples used by technically trained personnel. Any change to the application 
examples is your responsibility. Sharing the application examples with third parties or copying the 
application examples or excerpts thereof is permitted only in combination with your own products. 
The application examples are not required to undergo the customary tests and quality inspections 
of a chargeable product; they may have functional and performance defects as well as errors. It is 
your responsibility to use them in such a manner that any malfunctions that may occur do not 
result in property damage or injury to persons. 
 

Disclaimer of liability 
Siemens shall not assume any liability, for any legal reason whatsoever, including, without 
limitation, liability for the usability, availability, completeness and freedom from defects of the 
application examples as well as for related information, configuration and performance data and 
any damage caused thereby. This shall not apply in cases of mandatory liability, for example 
under the German Product Liability Act, or in cases of intent, gross negligence, or culpable loss of 
life, bodily injury or damage to health, non-compliance with a guarantee, fraudulent 
non-disclosure of a defect, or culpable breach of material contractual obligations. Claims for 
damages arising from a breach of material contractual obligations shall however be limited to the 
foreseeable damage typical of the type of agreement, unless liability arises from intent or gross 
negligence or is based on loss of life, bodily injury or damage to health. The foregoing provisions 
do not imply any change in the burden of proof to your detriment. You shall indemnify Siemens 
against existing or future claims of third parties in this connection except where Siemens is 
mandatorily liable. 

By using the application examples you acknowledge that Siemens cannot be held liable for any 
damage beyond the liability provisions described. 
 

Other information 
Siemens reserves the right to make changes to the application examples at any time without 
notice. In case of discrepancies between the suggestions in the application examples and other 
Siemens publications such as catalogs, the content of the other documentation shall have 
precedence.  

The Siemens terms of use (https://support.industry.siemens.com) shall also apply.  
 

Security information 
Siemens provides products and solutions with Industrial Security functions that support the secure 
operation of plants, systems, machines and networks. 

In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. 
Siemens’ products and solutions constitute one element of such a concept. 

Customers are responsible for preventing unauthorized access to their plants, systems, machines 
and networks. Such systems, machines and components should only be connected to an 
enterprise network or the Internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.  

For additional information on industrial security measures that may be implemented, please visit 
https://www.siemens.com/industrialsecurity. 

Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
at: https://www.siemens.com/industrialsecurity. 

 

https://support.industry.siemens.com/
https://www.siemens.com/industrialsecurity
https://www.siemens.com/industrialsecurity
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1 Introduction 

1.1 Overview 

The standardization of automation engineering for processing plants, such as 
in the chemical industry, is a major challenge. Different process steps and 
procedures, different equipment and flexibility in the production make the task 
even more difficult.  

This includes the configuring of the plant according to the physical model of the 
ISA 106 standard. This specifies the lower four levels, i.e. plant, unit, plant unit and 
control module. A plant always consists of units. The units can, in turn, comprise 
plant units which can be automated by equipment modules. 

The unit template "polymerization reactor" contains pre-made, standardized and 
ready-interconnected equipment modules and control module types. Using this 
sample solution as a basis, numerous instances with different parameter 
assignments can be generated with adapted characteristics to be widely integrated 
in automation solutions. The PCS 7 project is configured to be hardware-
independent and can be flexibly incorporated in existing projects. 

Differentiation 

This automation solution is designed for a polymerization reactor in the continuous 
or semi-continuous operation. During semi-continuous operation different sorts 
(Grades) of a polymer are alternately produced in a reactor. The grade change 
requires a change in the reaction conditions during the running process. The 
automation of the grade change is a particularly challenging technical control task. 
The unit template could also be adapted for batch operation. In batch operation, 
the specifications for the quantities of raw materials and the product discharge are 
done through a recipe control. However, it should be checked whether non-
linearities of the process dynamics require special adaptations to the regulatory 
approach, especially for the start-up phase of the reaction. 

In the template, the technical process within the polymerization reactor is only 
simulated as a much simplified and linearized process. After the simulation has 
been extended, the unit template could also be used within the framework of an 
operator training system. 

Required experience 

Fundamental knowledge of the following specialist fields is a prerequisite: 

 Engineering with SIMATIC PCS 7 and APL 

 Knowledge of control technology 

 Basic knowledge of process technology 

 An understanding of the concept of the equipment modules 
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1.2 Mode of operation 

A polymerization reactor is an integral part of many chemical processes. 
Polymerization reactors can be designed for continuous as well as discontinuous 
operation with different volumes. The selection of a specific reactor is based on 
typical specifications which include: 

 Production volume and polymer formation 

 Reaction rates, aggregate states of monomers, comonomers and polymers 

 Viscosity, thermal stability 

This application example contains a polymerization reactor with circulation cooling 
for continuous operation. 

During the manufacturing process of polymers, the monomer, comonomer, 
hydrogen reactants as well as the catalyst and cocatalyst, among others, are 
added and stirred in the reactor. The use of an MPC control (Model Predictive 
Control), improves the quality of the manufacturing process or the product. 

The unit template "polymerization reactor" has been implemented as a PCS 7 
multiproject as follows: 

 One project for the automation system (AS) and one project for the operator 
station (OS) are respectively contained in the component view. 

 A hierarchy folder has been set up in the technical hierarchy for each technical 
function of the polymerization reactor. 

In the AS project, all open- and closed-loop control functions are implemented in 
the form of CFC (Continuous Function Chart) charts. Furthermore, the AS project 
also contains a hierarchy folder with simulation charts that simulate a procedure, 
e.g. the filling level change, within a technical function. 

NOTE Technical functions are referred to as equipment modules, whereas individual 
control units and individual control unit types are called control modules or 
control module types. This documentation uses the terms: equipment module, 
control module (CM) and control module type (CMT). 

 

All equipment modules are available in the project's master data library as control 
module types and contain function blocks of the PCS 7 Advanced Process Library 
(APL) and of the Industry Library (IL). 

The OS project comprises the visualization of the polymerization reactor with all 
equipment modules and shows: 

 A schematic structure of a polymerization reactor 

 The relevant parameters (KPI: Key Performance Indicators) 

 The procedural control of a continuous production process 
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1.2.1 Core functionality 

The visualization interface of the "Polymerization Reactor" unit template is 
composed of the following pictures: 

 Plant overview picture for orientation and navigation (Level 1) 

 Process screen for operation and monitoring (Level 2) 

 Detailed process screen in P&ID representation with all components (Level 3) 

 

Plant overview 

The overview picture consists of the following objects: 

 Spider graph representation of typical polymerization reactor parameters and 
feeds. 

 Bar graph representation of the concentration and melt flow index from the 
product 
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Process image 

The process screen shows the most important process values for monitoring and 
operating the polymerization reactor. From the associated faceplate, you can get 
further detailed information about each displayed value and make changes. The 
trend display shows the actual, target and control variables of the multivariable 
controller. 

 

Detailed process screen 

The process picture of a polymerization reactor consists of the following parts:  

 A schematic representation of the unit, with input (arranged on the left) and 
output (arranged on the right) materials 

 Graphic modules for controlling the individual components (units) 

 SFC for the start and production operation 

 Overview of the relevant parameters (Key Performance Indicators) and 
operating hours display 

In the process picture, the operator is provided with an overview of the unit and can 
carry out the necessary operator intervention. 
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Control concept 

A multivariable control (MPC) is used to control the concentration of the gaseous 
materials in the reactor and the product quality (melt flow index of the polymer) by 
taking over setpoint value specifications for the inflows (comonomer, hydrogen, 
catalyst) during the process. 

If measurable disturbances occur in the system, and the process is significantly 
influenced, these can be used for the feedforward control. 

For the subordinate controllers, the PID controller "PIDConL" of the APL is 
employed for the flow rate of the comonomer, the hydrogen and the catalyst. All 
other controllers are also equipped with PID controllers, however they are designed 
as standard, split range, cascade or ratio controllers. 

 

1.3 Components used 

This application example has been created with the following hardware and 
software components:  

Component Note 

SIMATIC PCS 7 ES/OS IPC547G W7 For the PCS 7 V9.0 SP1 example project 

SIMATIC PCS 7 V9.0 SP1 Part of SIMATIC PCS°7 ES/OS IPC547G 
W7 

S7-PLCSIM Not part of SIMATIC PCS 7 V9.0 SP1; 
appropriate licenses are required. 

Advanced Process Library V9.0 SP1 Part of SIMATIC PCS°7 V9.0 SP1 

PCS 7 Advanced Process Graphics V9.0 
SP1 

Not part of SIMATIC PCS 7 V9.0 SP1; 
appropriate licenses are required 

 

NOTE In case of different hardware, please take heed of the minimum requirements for 
installing the software components. The minimum requirements can be found in 
the Readme of the PCS 7 under follow link: 
https://support.industry.siemens.com/cs/ww/en/view/109750097. 

 

This application example consists of the following components:  

Component Note 

84061788_PolyReactor_PROJ_PCS7V90SP1.zip PCS 7 V9.0 SP1 example project 

84061788_PolyReactor_DOC_PCS7V90SP1_de.pdf This document 

 

Note The example project for PCS 7 V9.0 is available for download in the Extranet 
area of the entry: 
https://support.industry.siemens.com/cs/ww/en/view/84061788.  

This Extranet area is only visible if you have a Managed System Services 
contract. You can obtain detailed information at: 
https://support.industry.siemens.com/cs/ww/en/sc/4361. 

You can find an overview of all technical information and solutions, available to 
you exclusively in the Extranet, at the following topics page: 
https://support.industry.siemens.com/cs/ww/en/view/109755371. 

https://support.industry.siemens.com/cs/ww/en/view/109750097
https://support.industry.siemens.com/cs/ww/en/view/84061788
https://support.industry.siemens.com/cs/ww/en/sc/4361
https://support.industry.siemens.com/cs/ww/en/view/109755371
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2 Preparation and commissioning 

2.1 Preparation 

The following instructions describe how to commission the Unit Template by 
simulating the controller with the "S7 PLCSIM" program. If there is a real controller, 
you must configure existing hardware components in the HW Config. 

1. Copy the file "84061788_PolyReactor_PROJ_PCS7V90SP1.zip" into any 
folder on the configuration PC and then open the SIMATIC Manager. 

2. Click on "File > Retrieve" in the menu bar and select the file 
"84061788_PolyReactor_PROJ_PCS7V90SP1.zip". Then confirm by clicking 
on "Open". 

3. Select the folder in which the project is to be saved and confirm by clicking on 
"OK". 
The project is retrieved. 

4. Confirm the "Retrieve" dialog by clicking on "OK" and then click on "Yes" in the 
dialog to open the project. 

5. Right-click on "UT_PolyReactor_OS > OS01 > WinCC Appl. > OS" and then 
click on the menu command "Open object". 

6. Confirm the "Configured server not available" dialog with "OK". 

7. In WinCC Explorer, open the properties of your computer and, in the opened 
Properties dialog, click on the "Use Local Computer Name" button. 

  

 

8. Confirm the "Change computer name" message with "OK". 

9. In the WinCC Explorer, click on "File > Exit" and in the subsequent dialog 
select "Terminate WinCC Explorer and close project".  

10. Then confirm with "OK". 

11. Reopen the WinCC Explorer as described in step 5. 

12. Open by double-clicking on "Variables library". 

13. In the "WinCC Configuration Studio", open "Variables library > SIMATIC S7 
Protocol Suite > TCP/IP" and select the menu command "System parameters". 

14. In the "Unit" tab, check the "Logical device names" setting. If the "S7 PLCSIM" 
program is used, the device name "PLCSIM.TCPIP.1" is selected.  
A restart is required after a device name change. 

 

NOTE If the OS cannot establish a connection with the AS (grayed out module icons), 
select the logical device name "CP_H1_1" and restart the OS runtime. 
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2.2 Commissioning 

The following instructions show how the Unit Template is initialized. The project 
contains an SFC chart where all the important settings are configured so that die 
system reaches the operating point.  

To put into service, it is required that SIMATIC Manager is already open and that 
the Unit Template has been selected in the component view. 

Starting the simulation (S7 PLCSIM) 

1. To start the simulation, proceed as follows: 

2. Select "Tools > Simulate Modules" from the menu. 
The "S7 PLCSIM" dialog window opens. 

3. In the "Open project" dialog, select "Open project from file". 

4. Select the file "PolyReactor.plc" from the path  
<Project path>\UT_PolyReactor\UT_P_MP\PolyReactor.plc>. 

5. In the menu, change "PLCSIM(MPI)" to "PLCSIM(TCP/IP)".  

6. Switch to the component view of the SIMATIC Manager and mark 
"UT_PolyReactor_AS > AS01". 

7. On the menu bar, click on "Target system > Load" and confirm the "Load" 
dialog with "Yes".  

8. Confirm the "Stop target group" dialog with "OK" and the subsequent "Load" 
dialog with "Yes". 

Activate OS (WinCC runtime) 

To activate the OS, proceed according to the following instructions: 

1. Right-click on "UT_PolyReactor_OS > OS01 > WinCC Appl. > OS" and click on 
the menu command "open object". 

2. To activate the OS (WinCC Runtime), select the menu command "File > 
Activate" in WinCC Explorer. 

3. In the "System Login" dialog, enter the user "Unit" as "Login" and "Template" 
as the password; then confirm with "OK". 

4. Select "Reactor" in the icon area 
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NOTE The polymerization reactor is already located in the production process because 
the AS program execution (PLCSIM) has been started. 

 

2.3 Description of the individual functions 

1

2

3

2
6

5

4

 

The process picture of a polymerization reactor consists of the following main 
parts: 

1. Inflow of input materials (educts) 

2. Level control over product outflow 

3. Temperature control (jacket and reactor internal temperature) 

4. Pressure control 

5. Mixers 

6. Polymerization reactor 

 

(1) Inflow of input materials (educts) 

The input materials are added to the vessel via the inflow and in the defined flow 
volume. Different control concepts are used for flow control. These include: 

 Ratio control 

 Standard control 

 Multivariable control for the presetting of educt inflow setpoint values as 
downstream controls 
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(2) Level control over product outflow 

The flow volume of the outflowing product depends on the fill level of the 
polymerization reactor and is controlled in a way that the reactors fill level remains 
constant. Whenever there's a fill level change (due to a difference between the 
inflowing and outflowing volumes) the controller reacts to the fill level changes and 
compensates them by lowering or increasing the outflow volume. 

(3) Temperature control (jacket and product temperature) 

For the chemical reactions to take place it is required to have the correct 
temperature of the materials in the reactor (vessel). Due to the temperature 
dependency of the reaction speed and the exothermic or endothermic chemical 
reactions, reactor temperature control is a very demanding task. This requirement 
is fulfilled by using a stirred tank reactor with jacket cooling. The required reaction 
temperature or reaction environment is preset via the vessel jacket. In order to 
dissipate the reaction heat of the highly exothermic polymerization, a part of the 
reactor contents is also pumped through an external heat exchanger. This pumped 
circulation is necessary, since the heat dissipated from the wall between the 
reactor and the cooling jacket alone is not sufficient.  

Rapid cooling (through an exothermic reaction) of the reaction mass is done by 
channeling cooling water as a service medium through the heat exchanger, which 
removes the reaction heat formed by the reaction. In endothermic reactions, the 
heat of the reaction mass has to be accordingly supplied (not considered in this 
project). 

To reach the preset jacket temperature, the vessel's jacket temperature is 
controlled with heating steam or cooling water. The vessel jacket influences the 
temperature inside the reactor with a small lag.  

(4) Pressure control 

The proper pressure within the vessel and an optimal composition of the gas phase 
for the reaction in the reactor are required for chemical reactions to take place. To 
fulfill this requirement, a preset vessel pressure is set via the pressure control and 
kept constant as much as possible. To increase the pressure, nitrogen is added via 
a supply line as an inert gas that doesn't participate in the chemical reaction. To 
reduce the pressure, an outlet valve is opened, thus allowing the gas mixture to 
escape from the container.  

This type of control is called split range control and it can also be used for other 
tasks, independent from the reactor, where two actuators should controlled by the 
controller (e.g. temperature control with separate actuators for heating and 
cooling). 

(5) Mixers 

The motorized mixer has the task of mixing the added educts or components 
together and to form a uniform distribution of the material concentration and 
temperature within the reactor. To avoid damage to the mixer, the mixer must be 
disabled if the level falls under a certain limit. 
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(6) Polymerization reactor 

Chemical reactions take place in the polymerization reactor. The selection and 
design of the reactor is done while taking account of procedural contexts, part of 
which can be very complex.  

These include: 

 Reaction mixtures that require a special frame size or vessel properties 

 Inflow and outflow volumes to determine the reactor size 

 Reaction sequence in the necessary environmental requirements 
(temperature, pressure, mixing) 

The concentration of various substances in the reactor and the melt flow index of 
the polymer are also recorded and used for flow rate and temperature control. 

Parameters (KPI: Key Performance Indicators) 

The key performance indicators are measured or calculated: 

 Dwell time 

 Space-time yield 

 Catalyst productivity 

 Operating hours counter 

 The process picture contains the following operating hours counters: 

 Motor of the mixer 

 Pump for diluent (educt) 

 Pump for cooling/heating medium of the vessel jacket 

 Pump for cooling/heating medium of the heat exchanger 
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2.4 Controlling the application 

2.4.1 Overview 

Some of the polymerization reactor's components can be operated and monitored 
by means of the process picture. In addition, the plant operator receives 
information (KPI's) for the current process. 

 

NOTE Please note that after CPU start it takes about 15 minutes until the plant goes in 
production operation, which meets the specified quality requirements. During the 
running production operation, all controllers are enabled. You can identify this 
state in the SFC when it has successfully processed all sequences, among 
others. 

 

The following scenarios relate to the handling of the "Polymerization Reactor" unit 
template: 

 Procedure for controller optimization 

 MPC working point optimization 

 Monitoring the progress of the process with APG 

 

2.4.2 Scenario A –Procedure for controller optimization 

Thanks to its wide range of control loops, this application offers a great way to 
perform optimizations for individual control loops, starting with simpler controls, 
such as fill level control, to complex multivariable controls for polymerization. The 
basic procedure for controller optimization is described in the following. 

After a successful startup of the plant, all controllers are enabled, so that separate 
setpoint values can be specified after switching to the internal setpoint value. 

Standard PID controller 

The PID controls, with the exception of the slave controller of the MPC and the 
motor staging, operate independent from the process simulation of the MPC.  

The Following optimization is explained using the example of the flow 
"FIC_Cocatalyst" and described only until the optimization dialog. A detailed 
description for the controller optimization can be found in the application notes: 

 "How do you do perform controller optimization with the PCS 7 PID tuner?" 
under https://support.industry.siemens.com/cs/ww/en/view/8031495 

 "PID Control with Gain Scheduling and PID Tuning" under 
https://support.industry.siemens.com/cs/ww/en/view/38755162 

 

1. In the OS, switch to the process picture and select the block icon 
"FIC_Cocatalyst". This will open the corresponding faceplate. 

https://support.industry.siemens.com/cs/ww/en/view/8031495
https://support.industry.siemens.com/cs/ww/en/view/38755162
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2. Change the setpoint value specification to the internal setpoint value. 

 

NOTE The setpoint value is tracked so that the switchover does not bring about any 
changes. 

 

3. Change the faceplate in the "Parameters" range and activate the setting "PID 
optimization". 
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4. Switch to the SIMATIC Manager and open the chart partition "A", sheet "1" of 
the CFC chart "FIC_Cocatalyst". 

5. Select the controller block "C" and choose the menu command "Edit> Optimize 
PID controller ...". 

6. Carry out the controller optimization. 

NOTE Please note that the flow does not consist an integral part and the excitation to 
the optimization does not deviate much from the operating point. 

 

MPC controller 

The multivariable control is applicable for slower but more sophisticated processes. 
Before optimizing the multivariable controller, the slave controllers must first display 
a stable control behavior. This relates to the example of the educt flow and the 
temperature control via the heat exchanger. 

The steps are described until the optimization dialog for the following optimization. 
A detailed description for the MPC optimization, can be found in the application 
notes  

 "Fluidized Bed Dryer - Design of Model Predictive Control with Economical 
Steady State Optimization" under follow link: 
https://support.industry.siemens.com/cs/ww/en/view/61926069 

 "PCS 7 Unit Template "Distillation Column" using the example of the Chemical 
Industry" in chapter "Configuration of the MPC controller" under 
https://support.industry.siemens.com/cs/ww/en/view/48418663. 

 

NOTE Please note that in the listed applications, MPC controls are described with 
different numbers of controlled variables and disturbance variables. The basic 
procedure for controller optimization is however identical and can also be applied 
to this example. 

 

1. In the OS, Switch to the process image of the polymerization reactor and wait 
until all operating points are reached and the controllers are enabled. 

2. Open in order to monitor the trend display of the first process variable. 

 

https://support.industry.siemens.com/cs/ww/en/view/61926069
https://support.industry.siemens.com/cs/ww/en/view/48418663
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3. Perform an excitation for the first setpoint value and wait until the excitation 
process is complete. 

 

NOTE Depending on the controlled variable, it can take about 15 minutes until most of 
the excitation process is complete. From the trend diagram, you can determine 
the time and the influence of the excitation. This data allows you to determine the 
parameters for the excitation block "AutoExcitation". 

 

4. After the evaluation, remove, for example, the excitation in the trend display 
and wait again until this excitation process is complete. 

5. Carry out steps 3 and 4 for all controlled variables. 

6. Switch to the SIMATIC Manager and open the chart partition "A", sheet "1" of 
the CFC chart "XC_Polymer". 

7. Open the Trend display via the menu command "View> Trend display...". 

8. Add all four process values (CVx) and manipulated variables (MVx) of the 
trend display and parameterize the value ranges according to the configuration 
at the MPC. You can alternatively use the pre-made trend indicator in the MPC 
block. 

NOTE You can take the value ranges for the process values from the channel drivers in 
the slave controller and monitoring values.  
Alternatively, you can use the input parameters "SPxHiLim" and "SPxLoLim" for 
the process value limits, "MVxHiLim" and "MVxLoLim" for the manipulated 
variable limits at the MPC and switch them to visible. 

 

9. Parameterize the "AutoExcitation" block according to your records of the 
excitation process for all four manipulated variables (NumberMV = 4). 

NOTE Set the manipulated variables and the duration of the excitation process in a way 
that a change in the process value can be identified. 
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10. Start the trend logging and wait 30 seconds until the first values (no skips) are 
recorded.  

11. Start the excitation process in the visibly switched "AutoExcitation" block and 
wait until all excitation processes are fully completed. 

NOTE The excitation can take several hours, depending on the preset time. 

 

12. After completing the excitation, export the trend log. 

NOTE In the project path "<Project path>\UT_PolyReactor\UT_P_MP" you can find the 
exported trend log "MPC_Record_20140227.csv" for optimization. 

 

13. Select the block "MPC" and click in the menu bar "Edit > Configure MPC". 

14. In the MPC configurator, run the control design with the exported trend log. 

 

2.4.3 Scenario B – MPC working point optimization 

The MPC controller allows economic optimization of the stationary operating point 
under consideration of setpoint tolerance limits. To this end, deviations allowed by 
the controller (degrees of freedom) are defined, in which the setpoint values may 
move. This range is also referred to as the tolerance range. When the operating 
point optimization is activated, the controller finds the manipulated variables within 
the tolerance ranges, in sense of the most advantageous performance criterion. If 
there is no extra information (computation of the economic data) available for the 
control, the lowest tolerance values are approached. 

Define the performance criterion in the parameter view. To this end, you can define 
specific costs for each manipulated and controlled variable of the MPC that should 
be minimized, or revenues which should be maximized.  

The example considers the following dependencies: 

 The MVs 1…3 are educt streams and cause higher costs if they rise.  

 The MV 4 corresponds to the reactor temperature and reduces costs when it 
rises. At a higher temperature, the demand for cooling energy is reduced.  

 The CVs involve no costs, however they must be kept within specified 
tolerance ranges to produce a salable product. 

 The sale revenue depends on the product outflow. In a first approximation, the 
discharge is equal to the sum of the educt inflows. Since the main raw material, 
i.e. the monomer, is supplied at a constant rate, the product discharge may 
also be assumed to be approximately constant. 

The objective of the optimization is therefore to achieve the required specifications 
with the least possible use of raw materials and cooling energy. 

The minimization of costs is taken as a basis for the performance criterion. 

To this end, the following gradient for MV 1…4 is set: 

1. GradMV1 = 11 

2. GradMV2 = 12 

3. GradMV3 = 22 

4. GradMV4 = -8 
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1. In the OS, Switch to the process image of the polymerization reactor and wait 
until all operating points are reached and the controllers are enabled.  

2. Click on the module symbol of the "XC_Polymer" multivariable controller and 
verify the limit value settings for the optimization (parameter assignment) of all 
control variables. 

 

 

3. For the optimization, set the gradients (weighting factors) for MV1 to MV4 with 
the optimization goal of cost minimization. 
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4. To monitor the MPC control, open the "Trend_MPC" trend display by means of 
the "Call up / consolidate curve groups" button. 

 

NOTE The trend display can also be extended to other values, such as the current 
economic revenue from the performance criterion. 

 

5. To optimize, press the "Optimization" button and monitor the changes to the 
trend indicator. 

 

6. After about 14 minutes, the operating point optimization is mostly completed. 

7. Stop the trend tracking in order to carry out an evaluation of the recorded data. 
For this purpose, you can also adjust the scaling of the time axis. 

NOTE The individual controller values (SPs, CVs and MVs) are archived, so that you 
can select your own time ranges in the trend indicator. 
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Evaluation 

SP2

CV2

MV2

SP1
CV1

MV1

SP3 CV3

MV3

SP4
CV4

MV4

 

After switching on the optimization, the MPC adopts the lower optimization limits for 
SP1 and SP2 and the upper optimization limits for SP 3 and SP4 as new setpoint 
values according to the weighting in the performance criterion. All manipulated 
variables (MV) are passed on to the downstream controls as setpoint value 
specifications. 

In terms of product quality, this means a higher MFI at lower concentrations. A 
higher product temperature (MV4) is required for the higher MFI. For a higher 
product temperature, the downstream control itself requires less cooling water to 
be passed through the heat exchanger, which in turn may result in lower costs. 

In this sample calculation, the operating point optimization can reduce costs by 
more than 10% from 1640 €/h to 1464 €/h with the adopted performance criteria.  

 

NOTE To perform an effective and meaningful optimization, it is necessary to provide 
the MPC with additional process-related technical data and limits, as well as 
basic economic information (revenues and costs). Costs or revenues, which do 
not have to depend on a constant factor of the manipulated or controlled 
variables of the MPC, must be calculated if required. This calculation of the 
economic data is to be carried out in a separate CFC and interconnected with 
the MPC.  

You can find a good example of an economic operating point optimization in the 
example "Fluidized Bed Dryer - Design of Model Predictive Control with 
Economical Steady State Optimization" under the follow link: 
https://support.industry.siemens.com/cs/ww/en/view/61926069 and the 
application example with integrated process simulation "PCS 7 Unit Template 
"Dryer" using the example of the Chemical Industry" under 
https://support.industry.siemens.com/cs/ww/de/view/74747848. 

 

https://support.industry.siemens.com/cs/ww/en/view/61926069
https://support.industry.siemens.com/cs/ww/de/view/74747848
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2.4.4 Scenario C – Monitoring the progress of the process with APG 

APG provides the plant operator with a rapid overview of all task-related process 
variables. Two process pictures of the polymerization reactor have been 
engineered with APG to demonstrate the functionality. 

In this scenario, process noise is activated and limit values and infeeds are altered 
so that messages can be monitored in the two APG process pictures (Level 1 and 
Level 2). 

Process noise for the jacket temperature and the reactor fill level is already 
activated when the plant is started up. Activating the noise on the "AddNoise" block 
provides a noise signal to the polymer density, melt flow index, H2 concentration, 
C4 concentration; C2 concentration and the polymer temperature. If you wish to set 
a stronger noise signal, you can set a larger value with the "StdDev"parameter in 
the noise blocks in the "Sim_Reactor" chart. Noise that is too great, e.g., when 
operating point optimization with a multi-variable controller is activated, has an 
influence on product quality as well as on control behavior. Depending on the 
deviation, it may be necessary to adjust the tolerance ranges for the operating 
points. If the fluctuations in several process variables are too great, the process will 
no longer be controllable. 

 

1. Switch to the SIMATIC Manager plant view and open the "Presettings" CFC in 
the path "UT_PolyReactor_MP > UT_PolyReactor_AS > Reactor > 
PolyReactor> Process > Presettings". 

2. Activate the test CPU from the "Debug > TestMode" menu item. 

3. Activate the display of all parameters in the "AddNoise" block and assign the 
value "1" to the "In1" parameter. 
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4. In the OS, switch to the "Reactor" process picture and open the limit value 
settings in the faceplate for the "Cat. Prod" measuring point.  

 

 

5. Set a lower warning limit of "290" and an alarm limit of "250". 

6. Open the faceplate for the "FIC_Monomer" measuring point.  

 

 

7. Change the setpoint specification to internal and assign a new flow rate value 
of "2900". 

NOTE Even the flow rate of solvent (diluent) is reduced as it is supplied in proportion to 
the monomer. 
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Evaluation 

By changing the flow volume, less monomer is supplied than is preset in the 
optimum working range. In addition, due to the ratio control even less solvent 
(diluent) is supplied to the reactor, which results in a temporary reduction in the fill 
level. The fill level controller corrects the disturbance variable with a lag. Due to the 
changed ratio of polymer density x polymer discharge to catalyst inflow, the level 
will be below the two set limits (alarm and warning) until the value settles in the 
region of "267", within the lower warning limit. 

The following representation shows the changes to the two process pictures, 
"Reactor" and "Plant". The optimum process status can be seen on the left, while 
the effects of the inflow change can be recognized in the right hand process 
picture. 

1

2

 

1. In the spider diagram in the "Plant" process picture, the effect of the catalyst 
productivity falling below the warning limit is represented by a yellow bar. 
Furthermore, from the polygon connection it can be recognized that the 
monomer flow rate is outside the working range.  

2. In the "Reactor" process picture, the vertical green arrow pointing down 
indicates that the monomer flow rate has fallen below the display range. Alarm 
and warning limits are not set for the flow rates.  
The yellow measurement display, the yellow flashing "W" symbol and the 
yellow warning limit in the bar graph indicate that the catalyst productivity has 
fallen below the lower warning limit. 
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3 Integrating the unit template in the user 
project 

3.1 Preparation 

1. Copy the file "84061788_PolyReactor_PROJ_PCS7V90SP1.zip" to the 
configuration PC and then open the SIMATIC Manager. 

2. Click on "File > Retrieve" in the menu bar and select the file  
"84061788_PolyReactor_PROJ_PCS7V90SP1.zip". Then confirm by clicking 
on "Open". 

3. Select the folder in which the project will be saved and confirm with the "OK" 
button. 
The project will be extracted. 

4. In the "Retrieve" dialog, click on the "OK" button and then click on "Yes" in the 
dialog to open the project. 

5. Switch to the "Plant view". 

6. At the same time, open the project in which the fermenter is to be integrated. 

3.2 Copying templates 

Note If you have already worked with CMTs in your existing project, then check that 
they are identical before skipping to the following steps, since this can lead to 
errors in your existing project or in the unit template you want to integrate. 

1. Switch to the plant view. 

2. Copy the "BCM" folder containing the CMTs from the master data library into 
the target project. 

 

 

3. Copy the Enumerations from the master data library into the target project. 



3 Integrating the unit template in the user project 

 

Polymerization Reactor 
Entry-ID: 84061788,    V1.3,    08/2018   27 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

8
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

3.3 Copying units 

1. Copy the hierarchy folder "Reactor" from the AS project of the Unit Template to 
the plant view of the target project. 

 

Note The hierarchy folders of the units "01_Overview" and "02_Help" are not 
necessary for operation.  

 

2. Copy the process screens "Plant", "Reactor" and "PolyRecator" from the OS 
project of the unit template to the plant view of the target project as well. If you 
wish, you can also copy the pictures "Help" and "Overview". 

 

Note When copying the process screens, make sure that you copy the pictures to the 
hierarchy level of the target project, which is configured as an OS area. 
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3.4 Adapting the OS project 

In order to facilitate the changing of colors in the process screen from a central 
point, a central color palette was created in the OS project of the Unit Template. To 
display these colors in the process screen of your own project, you must import the 
relevant color palette. 

1. Select the "OS" in WinCC Explorer and choose "Object properties..." in the 
shortcut menu. 

2. Choose the "User Interface and Design" (1) tab and click the "Edit" (2) button. 

3. Import the palette into your own project (3) by means of the "Overwrite" option. 
The color palette is located in the project folder of the unit template at the path: 
"<Project path>\UT_PolyReactor\UT_P_OS\wincproj\OS\GraCS\ 
UnitTemplate.xml>". All existing colors will be replaced. 

 

Note Please note that all colors are always used when exporting/importing color 
palettes. It is not possible to export partial color tables.  

 

If you have created your own color tables in your project, you can also export them 
and use an editor to merge the tables in the XML file. Otherwise you can create a 
new color table in your project and configure the colors individually. Make sure, too, 
that the color index does not change, otherwise you will have to adjust the color 
settings of the objects in the process screen. Of course it is up to you to change the 
colors according to your requirements. 
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4 Engineering 

4.1 Equipment modules and control modules 

The unit template "Polymerization Reactor" consists of pre-made equipment 
modules and additional CFC charts, e.g. for process simulation. In a PCS 7 project, 
all control modules – such as of the equipment modules – are based on control 
modules types from the master data library.  

The application example contains the following elements: 

 Educt addition (Feed): Feed control of the individual educts and catalysts 

 Level control (Level): Level control of the discharge 

 Jacket temperature control (JacketTemp): Control of the jacket temperature 

 Product temperature control (Cooling): Control of the reactor internal 
temperature 

 Pressure control (Pressure): Control of the tank pressure 

 Mixing (Agitation): Mixing of the product 

 Material concentrations and melt flow index (polymer) 

 Sequencer (SFC) for starting up the polymerization reactor 

 Overarching process simulation (Simulation) 

 Process parameters (KPI) 

 

Note All necessary descriptions, configurations and procedures pertaining to the  

 design, functionality of equipment modules including parameters 

 integration of equipment modules 

 controllers and control response 

can be found in the application description "Equipment Modules for SIMATIC 
PCS 7 using the example of the Chemical Industry" and the example projects 
with the individual equipment modules and CMTs at the following link: 
https://support.industry.siemens.com/cs/ww/en/view/53843373. You will find the 
information on the specific equipment modules in the chapter "Equipment 
Modules" and on the CMTs in the chapter "Control Module". 

 

In the following sections you will find the setup of the specific equipment modules 
as well as the extension and modifications made vis-à-vis the original equipment 
modules measurement point types. In addition, the SFC for starting up the 
polymerization reactor is documented. 

 

Note CMTs are pre-configured for different operating ranges. The use of variants 
allows the corresponding channel block to be selected or deselected based on 
measured value transfer. It is also possible to use options to activate additional 
functions without configuring the instance. 

 

https://support.industry.siemens.com/cs/ww/en/view/53843373
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4.2 Educt addition (feed) 

The total inflow is composed of various solid or gaseous educts. The inflow control 
is performed by a multivariable controller control modules (material concentration), 
a ratio control and a standard flow control with fixed setpoint value specifications 
through the step sequencer. 

4.2.1 Design 

Inflow of the cocatalyst via flow control 

The flow control (PID control) for the cocatalyst gets its setpoint value from the 
SFC. As with the monomer, the cocatalyst receives a fixed setpoint value for the 
production.  

The following table provides you with an overview of the elements  

CM CMT Selected variants Description 

FIC_Cocatalyst "Ctrl"  PV_In 

 Intlock 

Flow control of the cocatalyst, setpoint value 
from the SFC 

YC_Cocatalyst "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for "FIC_Cocatalyst" 

 

In the following figure, the structure with the cross-chart interconnection is depicted 
in simplified form. 

Sim_Feed

Lag_Cocatalyst

Gain_Cocatalyst

OUT

In1

FIC_Cocatalyst

PV_In

SimPV_In

to_Actor_Slave

Out

from_Actor_Slave

In

YC_Cocatalyst

V

MV

from_Ctrl

In

to_CtrlL

Out

 

 

Inflow via ratio control 

Two inflows are realized with the "Ratio-Control" technical function. This includes 
the main monomer educt to which the other diluent educt is added in a specified 
(stoichiometrically meaningful) value.  
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The following table provides you with an overview of the elements. 

CM CMT Selected variants Description 

FIC_Monomer "Ctrl"  PV_In 

 Intlock 

Flow control of the main components 

YC_Monomer "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for "FIC_Monomer" 

FFIC_Diluent CtrlRatio  Intlock 

 Opt_IF_Master 

 PV_In 

Ratio control of the secondary component in 
relation to the main component 

YC_Diluent ValAn  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for "FFIC_Diluent" 

NS_PumpDiluent Mot  Intlock 

 Opt_1Fbk 

 Permit 

 Q 

Pump for diluent 

 

In the following figure, the structure with the cross-chart interconnection is depicted 
in simplified form. 

Sim_Feed

Lag_Monomer

Gain_Monomer

OUT

In1

Lag_Diluent

Gain_Diluent

OUT

In1

FIC_Monomer

PV_In

SimPV_In

from_ActorSlave

In

to_ActorSlave

Out

FFIC_Diluent

PV_In

SimPV_In

from_ActorSlave

In

to_ActorSlave

Out

from_Master

In

YC_Monomer

V

MV

from_CTRL

In

to_CTRL

Out

YC_Diluent

V

MV

from_CTRL

In

to_CTRL

Out
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Inflow via multivariable control 

The multivariable control "XC_Polymer" controls the reaction conditions 
(concentration of gases in the reactor) as well as the quality of the polymers. To 
achieve this, the controller detects the concentrations of the components C2, C4 
and H2 and delivers its manipulated variables as external setpoint values to the 
slave controllers "FIC_Catalyst" "FIC_Hydrogen" and "FIC_Comonomer". The 
multivariable controller also gives a setpoint value for the reactor temperature, see 
section 4.8. 

The following table provides you with an overview of the elements. 

CM CMT Selected variants Description 

FIC_Catalyst "Ctrl"  Intlock 

 Opt_IF_Master 

 PV_In 

Flow controller for catalyst, actuated by the MPC 

YC_Catalyst "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for "FIC_Catalyst" 

FIC_Hydrogen "Ctrl"  Intlock 

 Opt_IF_Master 

 PV_In 

Flow controller for hydrogen, actuated by the 
MPC 

YC_Hydrogen "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for "FIC_Hydrogen" 

FIC_Comonomer "Ctrl"  Intlock 

 Opt_IF_Master 

 PV_In 

Flow controller for comonomer, actuated by the 
MPC 

YC_Comonomer "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for "FIC_Comonomer" 
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In the following figure, the structure of the flow controller including all the cross-
chart interconnection is depicted in simplified form. 
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Simulation 

The simulation chart "Sim_Feed" provides simulations of the time lag, the process 
gain and the flow scaling for all inflows. 

1 2 3

4

 

1. Time lag in seconds "Lag_xxxxx", which is caused by the inertia of the actuator 
and also by the time constant of the flow sensor (incl. low-pass filter in the 
measuring instrument). 

2. The "Gain_xxxx" factor defines the process gain. 

3. The "Feed_xxxx" factor defines the scaling or the flow volume of the educts.  

4. Summation of all inflows. 

 

4.2.2 Parameter assignment 

FIC_Catalyst 

The following table shows the configuration of the instance from "Ctrl". 

Module Connection Value Usage 

C Gain 13.5 Controller gain 

C TI 1.8 Controller lag 

C SP_InHiLim 50.0 Maximum value of the internal setpoint 

C PropFacSP 0.5 P-action in feedback loop 

to_Master Out  
Interconnection for the multivariable controller 
(XC_Polymer\from_Ctrl3.In) 

to_ActorSlave Out  
Interconnection for the valve (control) 
(YC_Catalyst\from_Ctrl.In) 

from_ActorSlave In  
Interconnection for the valve (status) 
(YC_Catalyst\to_Ctrl.Out) 

PV_In SimOn 1 Activate the simulation values  

PV_In SimPV_In  

Interconnection for the simulated process 
value 
(Sim_Feed\Gain_Catalyst.Out) 

PV_Scale HiScale 150.0 Maximum value of the process value 

PV_Unit In 1324 Unit of the process value (kg/h) 
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FIC_Hydrogen 

The following table shows the configuration of the instance from "Ctrl". 

Module Connection Value Usage 

C Gain 22.5 Controller gain 

C TI 1.4 Controller lag 

C SP_InHiLim 50.0 Maximum value of the internal setpoint 

C PropFacSP 0.5 P-action in feedback loop 

to_Master Out  
Interconnection for the multivariable controller 
(XC_Polymer\from_Ctrl2.In) 

to_ActorSlave Out  
Interconnection for the valve (control) 
(YC_Hydrogen\from_Ctrl.In) 

from_ActorSlave In  
Interconnection for the valve (status) 
(YC_Hydrogen\to_Ctrl.Out) 

PV_In SimOn 1 Activate the simulation values  

PV_In SimPV_In  
Interconnection for the simulated process value 
(Sim_Feed\Gain_Hydrogen.Out) 

PV_Scale HiScale 120.0 Maximum value of the process value 

PV_Unit In 1349 Unit of the process value (m
3
/h) 

 

FIC_Comonomer 

The following table shows the configuration of the instance from "Ctrl". 

Module Connection Value Usage 

C Gain 5.29 Controller gain 

C TI 5.372 Controller lag 

C SP_InHiLim 180.0 Maximum value of the internal setpoint 

C PropFacSP 0.5 P-action in feedback loop 

to_Master Out  
Interconnection for the multivariable controller 
(XC_Polymer\from_Ctrl1.In) 

to_ActorSlave Out  
Interconnection for the valve (control) 
(YC_Comonomer\from_Ctrl.In) 

from_ActorSlave In  
Interconnection for the valve (status) 
(YC_Comonomer\to_Ctrl.Out) 

PV_In SimOn 1 Activate the simulation values  

PV_In SimPV_In  
Interconnection for the simulated process value 
(Sim_Feed\Gain_Comonomer.Out) 

PV_Scale HiScale 500.0 Maximum value of the process value 

PV_Unit In 1324 Unit of the process value (kg/h) 
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FIC_Monomer 

The control module has the following different configuration when compared to the 
"ratio control". 

Module Connection Value Usage 

C Gain 0.618 Controller gain 

C TI 7.211 Controller lag 

C SP_InHiLim 8000.0 Maximum value of the internal setpoint 

PV_In SimPV_In  
Interconnection for the simulated process value 
(Sim_Feed\Gain_Monomer.Out) 

PV_Scale HiScale 8000.0 Maximum value of the process value 

PV_Unit In 1324 Unit of the process value (kg/h) 

 

FFIC_Diluent 

The control module has the following different configuration when compared to the 
"ratio control". 

Module Connection Value Usage 

C Gain 0.2 Controller gain 

C TI 1.0 Controller lag 

C SP_InHiLim 150.0 Maximum value of the internal setpoint 

Ratio RatioInt 0.01 Internal ratio value 

Ratio RatioExt 0.007105 External ratio value 

Ratio RatHiLim 1.0 Upper ratio value 

Ratio RatioOpScale 1.0 Scaling of the ratio value for the operator 

Ratio OutHiLim 150.0 Upper limit value for the output value 

PV_In SimPV_In  Interconnection for the simulated process value 

PV_Scale HiScale 150.0 (Sim_Feed\Gain_Diluent.Out) 

PV_Unit In 1349 Maximum value of the process value 

 

FIC_Cocatalyst 

The following table shows the configuration of the instance from "Ctrl". 

Module Connection Value Usage 

C Gain 23.0 Controller gain 

C TI 9.0 Controller lag 

C SP_InHiLim 4.0 Maximum value of the internal setpoint 

to_ActorSl
ave Out  

Interconnection for the valve (control) 
(YC_Cocatalyst\from_CTRL.In) 

from_Actor
Slave In  

Interconnection for the valve (status) 
(YC_Cocatalyst\to_CTRL.Out) 

PV_In SimOn 1 Activate the simulation values  

PV_In SimPV_In  
Interconnection for the simulated process value 
(Sim_Feed\Gain_Cocatalyst.Out) 

PV_Scale HiScale 4.0 Maximum value of the process value 

PV_Unit In 1324 Unit of the process value (kg/h) 
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YC_Catalyst 

The valve measurement point "YC_Catalyst" controls the flow volume (opening of 
the feed input) to the vessel. The measurement point contains communications 
modules for data exchange (control signals and control commands) with the 
controller measurement point. 

The valve module "V" contains an external manipulated variable (through a 
communications module) from the controller measurement point. In a simulation 
environment, both channel modules in chart partition "B" (Rbk and MV) receive the 
same value (manipulated variable of the valve module (chart partition "A", sheet 1)) 
through the primary simulation module, i.e. a lag between valve actuation and 
valve movement is not simulated. 

The following table shows the configuration of the instance from "ValAn". 

Module Connection Value Usage 

V MV  
Interconnection for the simulation 
(Sim_Feed\Lag_Catalyst.In) 

from_Ctrl In  
Switching off the alarm message with 
maximum valve opening 

to_Ctrl Out  
Switching off the alarm message with 
minimum valve opening 

Rbk SimOn 1 
Activate simulation of the read-back 
value 

Rbk SimPV_In  
Interconnection for the controller 
(FIC_Catalyst\V.MV) 

MV_Out SimOn 1 
Activate simulation of the manipulated 
variable output. 

 

YC_Hydrogen 

The valve measurement point "YC_Hydrogen" controls the flow volume (opening of 
the feed input) to the vessel. The measurement point contains communications 
modules for data exchange (control signals and control commands) with the 
controller measurement point. 

The valve module "V" contains an external manipulated variable (through a 
communications module) from the controller measurement point. In a simulation 
environment, both channel modules in chart partition "B" (Rbk and MV) receive the 
same value (manipulated variable of the valve module (chart partition "A", sheet 1)) 
through the primary simulation module, i.e. a lag between valve actuation and 
valve movement is not simulated. 

The following table shows the configuration of the instance from "ValAn". 

Module Connection Value Usage 

V MV  
Interconnection for the simulation 
(Sim_Feed\Lag_Hydrogen.In) 

from_Ctrl In  
Switching off the alarm message with 
maximum valve opening 

to_Ctrl Out  
Switching off the alarm message with 
minimum valve opening 

Rbk SimOn 1 Activate simulation of the read-back value 

Rbk SimPV_In  
Interconnection for the controller 
(FIC_Hydrogen\V.MV) 

MV_Out SimOn 1 
Activate simulation of the manipulated 
variable output. 
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YC_Comonomer 

The valve measurement point "YC_Comonomer" controls the flow volume (opening 
of the feed input) to the vessel. The measurement point contains communications 
modules for data exchange (control signals and control commands) with the 
controller measurement point. 

The valve module "V" contains an external manipulated variable (through a 
communications module) from the controller measurement point. In a simulation 
environment, both channel modules in chart partition "B" (Rbk and MV) receive the 
same value (manipulated variable of the valve module (chart partition "A", sheet 1)) 
through the primary simulation module, i.e. a lag between valve actuation and 
valve movement is not simulated. 

The following table shows the configuration of the instance from "ValAn". 

Module Connection Value Usage 

V MV  
Interconnection for the simulation 
(Sim_Feed\Lag_Comonomer.In) 

from_Ctrl In  
Switching off the alarm message with 
maximum valve opening 

to_Ctrl Out  
Switching off the alarm message with 
minimum valve opening 

Rbk SimOn 1 
Activate simulation of the read-back 
value 

Rbk SimPV_In  
Interconnection for the controller 
(FIC_Comonomer\V.MV) 

MV_Out SimOn 1 
Activate simulation of the manipulated 
variable output. 

 

YC_Monomer 

The control module has the following different configuration when compared to the 
"ratio control". 

Module Connection Value Usage 

V MV  

Interconnection for the simulation 

(Sim_Feed\Lag_Monomer.In) 

 

YC_Cocatalyst 

The valve measurement point "YC_Cocatalyst" controls the flow volume (opening 
of the feed input) to the vessel. The measurement point contains communications 
modules for data exchange (control signals and control commands) with the 
controller measurement point. 

The valve module "V" contains an external manipulated variable (through a 
communications module) from the controller measurement point. In a simulation 
environment, both channel modules in chart partition "B" (Rbk and MV) receive the 
same value (manipulated variable of the valve module (chart partition "A", sheet 1)) 
through the primary simulation module, i.e. a lag between valve actuation and 
valve movement is not simulated. 

The following table shows the configuration of the instance from "ValAn". 

Module Connection Value Usage 

V MV  
Interconnection for the simulation 
(Sim_Feed\Lag_Cocatalyst.In) 
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Module Connection Value Usage 

from_Ctrl In  
Switching off the alarm message with 
maximum valve opening 

to_Ctrl Out  
Switching off the alarm message with 
minimum valve opening 

Rbk SimOn 1 
Activate simulation of the read-back 
value 

Rbk SimPV_In  
Interconnection for the controller 
(FIC_Cocatalyst\V.MV) 

MV_Out SimOn 1 
Activate simulation of the manipulated 
variable output. 

 

YC_Diluent 

The valve measurement point "YC_Diluent" controls the flow volume (opening of 
the feed input) to the vessel. The measurement point contains communications 
modules for data exchange (control signals and control commands) with the 
controller measurement point. 

The valve module "V" contains an external manipulated variable (through a 
communications module) from the controller measurement point. In a simulation 
environment, both channel modules in chart partition "B" (Rbk and MV) receive the 
same value (manipulated variable of the valve module (chart partition "A", sheet 1)) 
through the primary simulation module, i.e. a lag between valve actuation and 
valve movement is not simulated. 

The valve measurement point is additionally connected to the "NS-PumpDiluent" 
pump. As soon as the valve opens, the interlock is released, thus allowing the 
pump to be started. 

The following table shows the configuration of the instance from "ValAn". 

Module Connection Value Usage 

V MV  

Interconnection for the simulation and pump 
(Sim_Feed\Lag_Cocatalyst.In) 
(NS_PumpDiluent\Limit.In) 

from_Ctrl In  
Switching off the alarm message with 
maximum valve opening 

to_Ctrl Out  
Switching off the alarm message with 
minimum valve opening 

Rbk SimOn 1 Activate simulation of the read-back value 

Rbk SimPV_In  
Interconnection for the controller 
(FIC_Cocatalyst\V.MV) 

MV_Out SimOn 1 
Activate simulation of the manipulated variable 
output. 

 

NS_PumpDiluent 

Pump control is done in CFC "NS_PumpDiluent", based on the CMT "Mot". The 
control modules type forms part of the master data library.  

The pump is controlled via SFC and is driven as soon as the downstream control 
valve "YC_Diluent" opens (MV > 0%). When the control valve is closed, the 
interlock of the pump is active. 
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4.3 Level control (Level) 

Level control is done via the product discharge and is realized with the "Level-
Control" equipment module. The level calculation is performed in the simulation 
chart. The reactor serves as a buffer, enabling a product discharge which is as 
continuous as possible. For this purpose, a dead band is defined in the controller 
CFC. 

4.3.1 Design 

The PID controller detects the fill level of the simulation chart and controls the 
discharge flow volume depending on the predetermined fill level. If the fill level 
comes below 30% of the reactor, the interlocking of the mixer is activated (mixer 
"Agitation"). The following table provides you with an overview of the elements. 

CM CMT Selected variants Description 

LIC_Reactor "Ctrl"  PV_In 

 Intlock 

Level control  

YC_Polymer "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for the product discharge 

NS_PumpReactor "Mot"  Intlock 

 Opt_1Fbk 

 Permit 

 Q 

Pump to feed the reactor contents 

Simulation "Sim_Level" 

In the "Sim_Level" simulation chart, the fill level is calculated on the basis of the 
difference between all inflows and the outflow.  

1 2 3 4

5
6 7

8

 

1. Lag time of 4 seconds, which is caused by the inertia of the actuator, and the 
time constant of the flow sensor. 

2. The gain factor for the simulation of the process gain. 

3. The scaling factor (negative inflow) for the polymer outflow volume.  

4. Summation of all inflows including discharge. 

5. Limiting the fill level by stopping the integration  

6. Integration of the inflow sum  

7. Fill level value with added noise signal 

8. White noise signal as a simulation for measurement noise. 
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4.3.2 Parameter assignment 

LIC_Reactor 

The control module has the following different configuration when compared to the 
"Level-Control" technical function. 

Module Connection Value Usage 

C Gain 1.5 Controller gain 

C TI 100.0 Controller lag 

C DeadBand 5.0 Deadband width 

C SP_InHiLim 100.0 Upper limit of the inner setpoint value 

C PV_Out  

Interconnection for 
(Agitation\\NS_StirringMotor\Limit.In) 
(NS_PumpReactor\Limit.In) 

PV_In SimPV_In  
Interconnection for the simulated process value 
(Sim_Level\Noise_Level.Out) 

PV_Scale HiScale 100.0 Maximum value of the process value 

PV_Unit In 1342 Process value unit in % 

 

YC_Polymer 

The control module has the following different configuration when compared to the 
"Level-Control" technical function. 

Module Connection Value Usage 

V MV  
Interconnection for the simulation 
(Sim_Level\Lag_Polymer.In) 

 

NS_PumpReactor 

Pump control is done in CFC "NS_PumpReactor", based on the "Mot" control 
module type. The control module type forms part of the master data library.  

The pump is controlled via SFC and is driven as soon as the fill level increases (fill 
level > 0%). When the reactor is empty, the interlock of the pump is active. 
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4.4 Jacket temperature control (JacketTemp) 

The jacket temperature control realized with the "Split–Range–Temperature" 
technical function provides the basis for an appropriate reaction environment. The 
"Mot" control module type is additionally used for the pumped circulation of the 
jacket fluid. The temperature calculation takes place in the simulation chart. 

4.4.1 Design 

The PID controller detects the jacket temperature and increases or lowers it 
according to the SFC temperature specification through the heating steam or 
cooling water service media.  

The following table provides you with an overview of all elements. 

CM CMT Selected variants Description 

TIC_Jacket "CtrlSplit
Range" 

 PV_In 

 Intlock 

Slave controller for the split-range control with 
one controller output and two actuators 

YC_Jacket_C "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Actuator for heating steam 

YC_Jacket_H "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for the cooling water 

NS_PumpJacket Mot  Intlock 

 Opt_1Fbk 

 Permit 

 Q 

Pump (e.g. flow pump) for the continuous 
pumped circulation of the jacket fluid 

 

NOTE The display control module and the controller control module of the "TIC_Temp" 
master controller of the "Split–Range–Temperature" equipment module are not 
needed in this case and are therefore not part of the solution. For this reason, 
the communication blocks "to_Master" and "from_Master" have been deleted in 
the "TIC_Jacket" control module. The missing control modules and 
interconnections have no effect on the functionality and are not described 
separately. 

 

Simulation Sim_JacketTemp  

The "Sim_JacketTemp" CFC chart (part of the "Split–Range–Temperature" 
technical function) was reduced to the simulation part of the heat exchanger 
("TempLevel" block) and contains an additional noise signal. 
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The figure below shows the structure and sequence of the simulation. 

1

2

 

1. Generating a noise signal (process behavior) 

2. Adding the noise signal to the temperature value of the reactor jacket and 
environment-related drop in temperature (0.001 degree Celsius) 

 

NS_PumpJacket 

Pump control is done in CFC "NS_PumpJacket", based on the "Mot" control 
module type. The control module type forms part of the master data library.  

 

NOTE You will find the information on the description, configuration and procedure of 
the control module type "Mot" in chapter 4 "Individual Control Level" of the 
documentation under 
https://support.industry.siemens.com/cs/ww/de/view/53843373. 

 

NOTE The interlocking of the pump can be carried out (configured) for the following 
cases: 

 if the controller is turned off 

 a leak is detected in the jacket 

 

4.4.2 Parameter assignment 

The temperature control via the reactor jacket is configured for autonomous 
operation. Since no effects of other system components are simulated in this 
example and the controller has a fast response, no changes shall be carried out for 
this example. 

 

https://support.industry.siemens.com/cs/ww/de/view/53843373
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4.5 Product temperature control (Cooling) 

The temperature control is used for the heat dissipation of the reaction heat. To 
counteract the resulting reaction heat, a portion of the contents of the reactor is 
continuously pumped through an external heat exchanger and cooled down with a 
service medium, such as cooling water. The temperature control is realized with 
the "Temperature-Flow Cascade" technical function.  

4.5.1 Design 

The master controller of the motor staging gets the setpoint temperature of the 
polymer melt defined as an external setpoint value from the "XC_Polymer" 
multivariable controller. The master controller "TIC_Polymer" gives the flow volume 
of the service medium to the "FIC_ServMedium" slave controller as an external 
setpoint value. 

The following table provides you with an overview of all elements. 

CM CMT Selected variants Description 

TIC_Polymer "CtrlSplit
Range" 

 Opt_IF_Master 

 PV_In 

 Intlock 

Master controller to control the temperature  

FIC_ServMedium "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Slave controller for the flow control  

YC_ServMedium "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for the coolant 

 

Simulation 

The flow volume of the cooling water to the heat exchanger is simulated in the 
simulation chart. In the "Sim_Reactor" process simulation, the change in 
temperature (temperature increase due to the chemical process and the cooling 
down through the Service medium) is simulated again. 

1 2

 

1. Lag time of 4 seconds, which is caused by the inertia of the actuator as well as 
by the time constant of the flow sensor. 

2. The gain factor for the simulation of the process gain. 
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4.5.2 Parameter assignment 

TIC_Polymer 

The control module is connected with the blocks "to_Master" and "from_Master" to 
the "XC_Polymer" multivariable control measuring point. The manipulated variable 
of the multivariable controller measurement point is used as an external setpoint 
value for the control. 

The "from_Master" block passes control commands from the PID controller 
("SP_InHiOut", "SP_InLoOut", "PV_Out", "CascaCut", "PV_UnitOut") to the MPC 
controller. 

The control module has the following different configuration when compared to the 
"Temperature-Flow-Cascade" technical function. 

Module Connection Value Usage 

C NegGain 1 Negative controller gain 

C Gain 2.0 Controller gain 

C TI 20.0 Controller lag 

C SP_InHiLim 90.0 Maximum value of the internal setpoint 

from_Master In  

Manipulated variable of the multivariable 
controller 
(XC_Polymer\to_Ctrl4.Out) 

to_Master Out  

Interconnection of the multivariable measuring 
point 
(XC_Polymer\from_Ctrl4.In) 

PV_Scale HiScale 120.0 Maximum value of the process value 

 

FIC_ServMedium 

The control module has the following different configuration when compared to the 
"Temperature-Flow-Cascade" technical function. 

Module Connection Value Usage 

C Gain 2.769 Controller gain 

C TI 1.639 Controller lag 

C SP_InHiLim 400.0 Maximum value of the internal setpoint 

PV_Scale HiScale 400.0 Maximum value of the process value 

PV_Unit In 1349 Unit of the process value (m
3
/h) 
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4.6 Pressure control (Pressure) 

The pressure control is realized with the "Split–Range–Pressure" technical 
function. The pressure calculation takes place in the simulation chart.  

4.6.1 Design 

The PID controller senses the vessel pressure from the simulation chart and 
increases the pressure with nitrogen or decreases it (ventilation) depending on the 
defined value. The following table provides you with an overview of the elements. 

CM CMT Selected variants Description 

PIC_Pressure "CtrlSplit
Range" 

 Opt_IF_Master 

 PV_In 

 Intlock 

Controller for the split-range control with one 
controller output and two actuators 

YC_Nitrogen "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for the nitrogen supply 

YC_Exhaust "ValAn"  Opt_IF_Ctrl 

 Permit 

 Rbk 

 MV_Out 

Control valve for ventilation  

 

4.6.2 Parameter assignment 

Since the focus of the application is not the pressure control and no effects are 
simulated from a fill level change or leakage, the simulation and the configuration 
remain unchanged. 

 

NOTE The Feature-Bit 25 is activated in the "V" block of the CFC "YC_Nitrogen" and 
"YC_Exhaust". 
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4.7 Mixing (Agitation) 

4.7.1 Design 

The mixer stirs the educts in the reactor. This is turned on or off by the plant 
operator or via a step sequencer. If a fill level comes below 30% of the reactor, the 
interlocking of the mixer is activated. The following table provides you with an 
overview of the elements. 

CM CMT Selected variants Description 

NS_StirringMotor "Mot"  Intlock 

 Opt_1Fbk 

 Permit 

 Q 

Stirring motor 

 

4.7.2 Parameter assignment 

NS_StirringMotor 

Mixer control is done in the CFC "NS_StirringMotor", based on the "Mot" control 
module type. This control module type is used for motors that have a constant rpm 
and forms part of the master data library. The "Limit" function has been additionally 
added in page 2 of chart partition "A" for interlocking when the fill level is falling 
short. 

The following table shows the configuration of the instance from "Mot". 

Module Connection Value Usage 

Limit OutHiLim 30 
Limiting value that indicates if the fill level 
has been exceeded 

Limit OutHiAct  
Interconnection for the interlocking 
(Intlock.In01) 
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4.8 Concentration and melt flow index (product) 

4.8.1 Design 

The multivariable control regulates the concentrations of hydrogen, comonomer 
and monomer (reaction conditions) as well as the melt flow index (MFI) as a 
measure of product quality. To this end, the controller defines its manipulated 
variables as external setpoint values for the downstream controls of the 
comonomer flow, hydrogen flow, catalyst flow, and reactor temperature. 

The density calculated in the process simulation is additionally displayed in a 
separate measuring point. 

The product quality is not directly measurable in a polymerization reactor, but is 
determined by laboratory samples. Therefore, a soft sensor calculates the two 
most important parameters of the product quality: the melt flow index and the 
density of the polymer. This soft sensor is based on a physical model. Since the 
sensor has to be developed for a specific application, it is not part of this sample 
solution. 

The following table provides you with an overview of the elements 

CM CMT Selected variants Description 

XC_Product CtrlMPC  Opt_CPM_1 

 Opt_CPM_2 

 Opt_CPM_3 

 Opt_CPM_4 

 Opt_Ctrl_1 

 Opt_Ctrl_2 

 Opt_Ctrl_3 

 Opt_Ctrl_4 

Multivariable controller as a master controller 

QI_MFI AMon  Opt_IF_Ctrl 

 PV_In 

Measuring point for displaying the melt flow 
index 

QI_H2fraction AMon  Opt_IF_Ctrl 

 PV_In 

Measuring point for displaying the H2 
concentration 

QI_C4fraction AMon  Opt_IF_Ctrl 

 PV_In 

Measuring point for displaying the C4 
concentration 

QI_C2fraction AMon  Opt_IF_Ctrl 

 PV_In 

Measuring point for displaying the C2 
concentration 

QI_Density AMon  Opt_IF_Ctrl 

 PV_In 

Measuring point for displaying the polymer 
density 
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In the following figure the structure with the cross-chart interconnection is depicted 
in simplified form. 

FIC_Comonomer
Sim_Reactor

V_Monomer

Out

MFI

Out

XC_Product

from_Ctrl1

In

from_Master

In

to_Master

Out

from_Ctrl2

In

to_Ctrl1

Out

to_Ctrl2

Out

FIC_Hydrogen

from_Master

In

to_Master

Out

V_Hydrogen

Out

P_part_CoMo

Out

FIC_Catalyst

from_Master

In

to_Master

Out

TIC_Reactor

from_Master

In

to_Master

Out

from_Ctrl3

In

from_Ctrl4

In

to_Ctrl3

Out

to_Ctrl4

Out

QI_H2fraction

PV_In

SimPV_In

to_MPC

Out

QI_C4fraction

PV_In

SimPV_In

to_MPC

Out

QI_C2fraction

PV_In

SimPV_In

to_MPC

Out

QI_MFI

PV_In

SimPV_In

to_MPC

Out

from_CV1

In

from_CV2

In

from_CV3

In

from_CV4

In
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Simulation 

 

 

In the "Sim_Reactor" simulation chart, a process variable is calculated in each 
sheet. Operating points, delays and interactions are defined for each process 
variable. The dynamic model describes deviations from the operating points for 
each process variable. 

For a description of the simulation, please refer to section 4.9. 

 

4.8.2 Parameter assignment 

XC_Polymer 

For controlling with the multivariable controller measurement point "XC_Polymer", 
the following variables are used and interconnected. 

CVs (Controlled Variables): 

 H2fraction 

 C4fraction 

 C2fraction 

 MFI 

MVs (Manipulated Variables, setpoint values for subordinate slave controllers): 

 Flow volume of comonomer educt 

 Flow volume of hydrogen educt 

 Flow volume of catalyst 

 Temperature inside the reactor 

The control module contains communications modules for connecting slave 
controllers and for displaying control variables, and is an instance from the control 
module type "CtrlMPC". 
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Module Connection Value Usage 

MPC MV1Man 138.0 Manipulated variable in setup mode 

MPC MV2Man 21.6 Manipulated variable in setup mode 

MPC MV3Man 30.6 Manipulated variable in setup mode 

MPC MV4Man 85.5 Manipulated variable in setup mode 

MPC DB_No 18 DB number with controller data 

MPC Restart 1 Restart and import of the data from the DB 

MPC CV4_Unit 
g / 
10min 

The user-specific unit has been entered in the 
line "CV4_Unit" and column "Unit" of the object 
properties of the MPC 

SP10ptHiLim In2 0.5 SP1 upper limit for MPC optimization 

SP10ptLoLim In2 -0.5 SP1 lower limit for MPC optimization 

SP20ptHiLim In2 0.1 SP2 upper limit for MPC optimization 

SP30ptLoLim In2 -0.1 SP2 lower limit for MPC optimization 

SP30ptHiLim In2 1.0 SP3 upper limit for MPC optimization 

SP30ptLoLim In2 -1.0 SP3 lower limit for MPC optimization 

SP40ptHiLim In2 0.1 SP4 upper limit for MPC optimization 

SP40ptLoLim In2 -0.1 SP4 lower limit for MPC optimization 

to_Ctrl1 Out  
Manipulated variable for the comonomer flow 
(Feed\\FIC_Comonomer\from_Master.In) 

to_Ctrl2 Out  
Manipulated variable for the hydrogen flow 
(Feed\\FIC_Hydrogen\from_Master.In) 

to_Ctrl3 Out  
Manipulated variable for the catalyst flow 
(Feed\\FIC_Catalyst\from_Master.In) 

to_Ctrl4 Out  

Manipulated variable for the product 
temperature 
(AirSupply\\FIC_HotAir\from_Master.In) 

from_Ctrl1 In  

Interconnection of the comonomer measuring 
point 
(Feed\\FIC_Comonomer\to_Master.Out) 

from_Ctrl2 In  

Interconnection of the hydrogen measuring 
point 
(Feed\\FIC_Hydrogen\to_Master.Out) 

from_Ctrl3 In  
Interconnection of the catalyst measuring point 
(Feed\\FIC_Catalyst\to_Master.Out) 

from_Ctrl4 In  

Interconnection of the product temperature 
measuring point 
(Cooling\\TIC_Polymer\to_Master.Out) 

from_CV1 In  
Interconnection for the H2 fraction display 
(Product\\QI_H2fraction\to_MPC.Out) 

from_CV2 In  
Interconnection for the C4 fraction display 
(Product\\QI_C4fraction\to_MPC.Out) 

from_CV3 In  
Interconnection for the C2 fraction display 
(Product\\QI_C2fraction\to_MPC.Out) 

from_CV4 In  
Interconnection for the flow index display 
(Product\\QI_MFI\to_MPC.Out) 
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NOTE Commissioning of the multivariable controller was carried out based on the 
"fluidized bed dryer" application description of a model predictive controller, with 
working point optimization. You will find the example under: 
https://support.industry.siemens.com/cs/ww/en/view/61926069. Before 
optimizing the controller, it is important to carry out an excitation for each 
manipulated variable (MPC in "Manual" operating mode) and to wait until the 
excitation completes for all process data. 

 

QI_H2fraction 

The display measuring point is used for the display and monitoring of the hydrogen 
(H2) concentration for the multivariable control measuring point. The operator can 
set alarm and warning limit values. 

The following table shows the configuration of the instance from "AMon". 

Module Connection Value Usage 

to_MPC Out 

 

Interconnection to the control variable of the 
multivariable controller 
(XC_Polymer\from_CV1.Out) 

PV_In SimOn 1 Activation of the simulation  

PV_In SimPV_In 

 

Interconnection for the simulated product 
temperature 
(Process\Simulation\Sim_Reactor\V_Hydrogen. 
Out) 

PV_Scale HiScale 50.0 Maximum value of the process value 

PV_Unit In 1562 Process value unit (%vol) 

 

QI_C4fraction 

The display measuring point is used for the display and monitoring of the 
comonomer (C4) concentration of the multivariable control measuring point. The 
operator can set alarm and warning limit values. 

The following table shows the configuration of the instance from "AMon". 

Module Connection Value Usage 

to_MPC Out 

 

Interconnection to the control variable of the 
multivariable controller 
(XC_Product\from_CV2.Out) 

PV_In SimOn 1 Activation of the simulation  

PV_In SimPV_In 

 

Interconnection for the simulated product moisture 
content 
(Process\Simulation\Sim_Reactor\P_part_CoMo.
Out) 

PV_Scale HiScale 4.0 Maximum value of the process value 

PV_Unit In 1562 Process value unit (%vol) 

 

https://support.industry.siemens.com/cs/ww/en/view/61926069
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QI_C2fraction 

The display measuring point is used for the display and monitoring of the monomer 
(C2) concentration of the multivariable control measuring point. The operator can 
set alarm and warning limit values. 

The following table shows the configuration of the instance from "AMon". 

Module Connection Value Usage 

to_MPC Out 

 

Interconnection to the control variable of the 
multivariable controller 
(XC_Product\from_CV3.Out) 

PV_In SimOn 1 Activation of the simulation  

PV_In SimPV_In 

 

Interconnection for the simulated product moisture 
content 
(Process\Simulation\Sim_Reactor\V_Monomer. 
Out) 

PV_Unit In 1562 Process value unit (%vol) 

 

QI_MFI 

The display measuring point is used for the display and monitoring of the melt flow 
index (MFI) of the multivariable control measuring point. The operator can set 
alarm and warning limit values. 

The following table shows the configuration of the instance from "AMon". 

Module Connection Value Usage 

to_MPC Out 

 

Interconnection to the control variable of the 
multivariable controller 
(XC_Product\from_CV4.Out) 

I PV_Unit 
g / 
10min 

The user-specific unit has been entered in the line 
"CV4_Unit" and column "Unit" of the object 
properties of the MPC 

PV_In SimOn 1 Activation of the simulation  

PV_In SimPV_In  

Interconnection for the simulated product moisture 
content 
(Process\Simulation\Sim_Reactor\MFI.Out) 

PV_Scale HiScale 2.5 Maximum value of the process value 

 

QI_Density 

The display measuring point is used to display and monitor the polymer density. 
The density is calculated in the process simulation and only connected for display 
purposes. The operator can set alarm and warning limit values. 

The following table shows the configuration of the instance from "AMon". 

Module Connection Value Usage 

PV_In SimOn 1 Activation of the simulation  

PV_In SimPV_In  
Interconnection for the simulated process value 
(Process\Simulation\Sim_Reactor\Density.Out) 

PV_Scale HiScale 1000.0 Maximum value of the process value 

PV_Unit In 1097 Process value unit (kg/m
3
) 
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4.9 Process simulation (Simulation) 

The CFC chart "Sim_Reactor" contains all of those parts of the simulation model 
that not only describe an individual system section but also have an overarching 
nature. The role of process simulation is to understand the functioning of the 
polymerization reactor, particularly in relation to the control functions of the 
multivariable controller or to be able to demonstrate it. It does not claim to replicate 
exactly the real physical behavior of a particular reactor.  

A matrix with linear, dynamic transfer functions is used as a model for process 
simulation. The process model is a 6x4 multi-variable system, whereby the 
influence of each input variable on every output variable is simulated by a separate 
partial transfer function. The model describes the temporal behavior of process 
deviations from the working point. The process simulation runs in time lapse, i.e. 
100 times faster than real-time. 

 

NOTE The CFC chart "Presettings" allows you to set the time lapse as well as reset the 
delays and activate or deactivate the process noise. 

 

Furthermore, the operating points lag times and downtimes can be parameterized 
for each process variable. The partial transfer functions are realized with different 
dynamic models (PT1, PT2 or PT3 behavior). Each partial transfer function receives 
the respective differential value from the predefined working point and the current 
value of the input variables and outputs them correspondent to its transfer 
functions at the output point. At the end, for each process output variable yi the 
associated working point is added. 

 

NOTE All PTn transfer functions are structured as 'chart in chart' according to the same 
principle, whereby only the required functional parts are activated. A transfer 
function contains three sequentially switched delay elements and a booster 
element. Furthermore, noise can be added to the output signal. 

 

In the following figure, the process model is depicted with the corresponding 
names. 

Feed

Comonomer

Feed

Hydrogen

Feed

Catalyst

Feed

ServMedium

MFI y1u1 y1u2 y1u3 y1u4

Density y2u1 y2u2 y2u3 y2u4

V_Monomer y3u1 y3u2 y3u3 y3u4

P_part_CoMo y4u1 y4u2 y4u3 y4u4

V_Hydrogen y5u1 y5u2 y5u3 y5u4

Temp_Polymer y6u1 y6u2 y6u3 y6u4

input variables

o
u
tp

u
t 
v
a
ri
a
b
le

s

 

 

The process variables "MFI" (melt flow index), "V_Monomer" (concentration of the 
monomer), "P_part_CoMo" (concentration of the comonomer) and "V_Hydrogen" 
(concentration of hydrogen) are required for multivariable control. The process 
variable "Temp_Polymer" is used to control the polymer temperature in the reactor, 
and "Density" to show the polymer density. 
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NOTE The numbering of the process variables does not match the numbering of the 
controlled variables of the MPC, but corresponds to the arrangement in the CFC 
chart. 

 

The following figure shows the simulation block (chart-in-chart) of Sheet 1 for the 
calculation of the MFI (melt flow index). Different process values are calculated in 
the same way with different parameters in each sheet. 

1

2

3

 

1. Calculation of the MFI 
The MFI is calculated in this block. The associated operating point as well as 
the delays (TPx_x), the dead time (DeadTime) and the gain (gain_x) are all 
specified under each connected parameter. In the block, the deviations on the 
operating point are calculated, added together and sent to the output in 
individual transfer functions for each interconnected manipulated variable 
(comonomer, hydrogen, catalyst and cooling water to the heat exchanger). 

2. Process noise 
In this block, an artificial error is created in the form of a fluctuation in the block. 
This error, as well as all other errors of the process simulation, is activated 
centrally in the CFC "Presettings". 

3. Output value 
In this block, the process value, if enabled, is given with accumulated process 
noise. 
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4.10 Sequencers 

At the start of production, the plant is run dry, the reactor is purged with nitrogen 
and then taken into production operation whereby the individual plant components 
approach their operating points.  

 

NOTE The composition and viscosity of the product produced at the beginning of the 
startup process does not meet the specified criteria, so that after a few minutes 
the desired or pre-selected product quality is delivered. 

 

Sequencers support the plant operator during start-up and shut-down of a plant or 
during errors. 

During start-up the process is placed in the defined operating point. The controllers 
are optimized for the specific operating point and are switched to automatic mode 
when reaching the operating point. This example takes the control of multivariable 
controllers after approaching the specified product quality (concentration, and melt 
flow index). 

Different behavior and modes of operation can be realized in SFC. In the sample 
project the SFC "StartReactor" is configured for automatic start-up without user 
interaction. After start-up, the controller is transferred to the user in automatic 
mode, allowing him to determine, for instance, the individual setpoint values. 

The following sequencers are components of the SFC and are described below: 

 PREPARING 

 STARTUP 

 RUNNING  

The SFC are designed for the simulation and can only be understood as a 
reference points for real plants, i.e. if necessary, they have to be modified for use in 
real systems. 

 

NOTE To determine the setpoint value and operating mode selection, the necessary 
parameterization is used, incl. the schematic representations from the function 
manual "SIMATIC Process Control System PCS 7 Advanced Process Library 
(V9.0 SP1)". In the function manual under the follow link: 
https://support.industry.siemens.com/cs/ww/en/view/109754967 you can find 
information on operating modes and setpoint value selection, as well as more 
detailed information on all parameters of the APL blocks. 

 

PREPARING 

When starting the polymerization reactor, the sequencer (sequence) 
"PREPARING" is performed at the beginning, which runs the unit in a non-
production operation. For this, all inflows are stopped, the reactor is emptied and 
flushed with nitrogen. 

The operational modes of all controllers except the pressure and level control 
switch to automatic and are updated to the manipulated variable "0". 

The pressure control and level control receive external setpoint values. 

https://support.industry.siemens.com/cs/ww/en/view/109754967
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STARTUP 

The sequencer "STARTUP" follows the sequencer "PREPARING". During the 
starting phase, the unit from the plant standstill (no production) is prepared for 
operation in its normal state. To accomplish this, all controllers receive external 
setpoint values and the tracking is stopped.  

The following steps are performed in the sequencer: 

1. Temperature control of the jacket temperature at 20°C 

2. Reactor fill level (setpoint value) of 60% 

3. Setting the MPC setpoint values (concentrations and melt flow index) and 
manipulated variables for the tracking. 

4. Setpoint value specification for all inflows and product temperature. All MPC 
slave controllers receive internal setpoint values, while the remaining 
controllers receive external setpoint values. The diluent pump is additionally 
activated. 

5. The remaining pumps and the mixer are activated after reaching a fill level of 
30%. The vessel also receives a setpoint value specification for the vessel 
pressure. 

6. After reaching the specified process variables (concentrations and melt flow 
index), the MPC goes into automatic mode and all slave controllers use the 
external setpoint value (manipulated variable of the MPC) for control. 

 

NOTE The MPC is taken in automatic mode, as long as the subordinate controllers still 
run with an internal setpoint value. As a result, all MPC outputs are tracked to the 
correct values from the sequence control circuits. The subordinate controllers are 
then switched to external setpoint values and the MPC switches smoothly 
channel-by-channel from tracking into automatic mode. 

 

RUNNING 

In the sequencer "RUNNING", operator input is enabled for all controllers and 
aggregates. To this end, the following parameters are changed: 

 for PID controllers: "ModLiOp" = 0 and "SP_LiOp" = 0 

 for MPC controllers: "ModLiOp" = 0 

 for aggregates (pumps und mixers): "ModLiOp" = 0 

 for valves: "ModLiOp" = 0 and "SP_LiOp" = 0 

Upon successful execution of the sequencer, the operator can define new setpoint 
values for the controller. 

 

NOTE The setpoint values of the slave controller from the motor staging cannot be 
changed due to the pre-defined program logic. At the ratio blocks, you can 
individually customize the inflows and therefore the setpoint values of the slave 
controller of the ratio control. 
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4.11 Process parameters (KPI) 

The CFC chart "KPI" comprises key performance indicators that inform the 
operator about the process performance. The following key performance indicators 
are calculated and shown in the visualization: 

1. Sheet dwell time (ResidenceTime): The dwell time is calculated from the 
quotient of the reaction volume and exiting volume flow. During this process, 
the reaction volume is calculated from the normalized fill level. The outflowing 

volume flow �̇�𝑃𝑟𝑜𝑑𝑢𝑐𝑡,𝑜𝑢𝑡 corresponds to the product outflow of the fill level 

control loop. 

𝜏 =
𝑙 ∙  𝑉 

�̇�𝑃𝑟𝑜𝑑𝑢𝑐𝑡,𝑜𝑢𝑡

 

 

2. Space-time-yield sheet (SpaceTimeYield): The space-time-yield describes the 

ratio between the incoming mass flows of educts 𝑚𝑣̇ 𝐸,𝑖𝑛 and the total volume of 

the reactor 𝑉𝑅. Since the inflows are partially present as mass flows and 
partially as volume flows in the simulation, the following relationship results for 
this application. 

𝑅𝑍𝐴 =
𝑚𝑣̇ 𝐸,𝑖𝑛

 𝑉𝑅

 

𝑚𝑣̇ 𝐸,𝑖𝑛 = 𝑚𝑣̇ 𝐶𝑜𝑚𝑜𝑛𝑜𝑚𝑒𝑟,𝑖𝑛 + 𝑚𝑣̇ 𝑀𝑜𝑛𝑜𝑚𝑒𝑟,𝑖𝑛 + 𝑚𝑣̇ 𝐶𝑎𝑡𝑎𝑙𝑦𝑠𝑡,𝑖𝑛 + 𝜌𝐻𝑦𝑑𝑟𝑜𝑔𝑒𝑛 ∙ 𝑚𝑣̇ 𝐻𝑦𝑑𝑟𝑜𝑔𝑒𝑛,𝑖𝑛 

 

3. Catalyst productivity sheet (CatProductivity): The catalyst productivity 𝐾𝐴 is 
derived from the ratio between the outflowing mass flow of the product 
𝑚𝑣̇ 𝑃𝑟𝑜𝑑𝑢𝑐𝑡,𝑜𝑢𝑡 and the inflowing mass flow of the catalyst 𝑚𝑣̇ 𝐶𝑎𝑡𝑎𝑙𝑦𝑠𝑡,𝑖𝑛. 

The density of the product is thereby calculated by the simulation model: 

𝜌𝑃𝑟𝑜𝑑𝑢𝑐𝑡 = 𝑦2 (See also Process simulation (Simulation)). 

𝐾𝐴 =
𝑚𝑣̇ 𝑃𝑟𝑜𝑑𝑢𝑐𝑡,𝑜𝑢𝑡

𝑚𝑣̇ 𝐶𝑎𝑡𝑎𝑙𝑦𝑠𝑡,𝑖𝑛

=
𝜌𝑃𝑟𝑜𝑑𝑢𝑐𝑡 ∙ �̇�𝑃𝑟𝑜𝑑𝑢𝑐𝑡,𝑜𝑢𝑡

𝑚𝑣̇ 𝐶𝑎𝑡𝑎𝑙𝑦𝑠𝑡,𝑖𝑛

 

 

NOTE The value for the catalyst productivity is coupled to the product discharge and 
changes according to the controller output of the discharge valve. Due to the 
predefined control gain factor, changes to the manipulated variables produce 
major value fluctuations. In practice, it is not the short-term fluctuations, but 
rather the long-term changes of the temporal mean value of the catalyst 
productivity that are preferred. 
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4.12 Task-related overview images with APG 

With PCS 7 Advanced Process Graphics, process pictures are displayed more 
clearly, reduced to the essential and are intuitive to use. The focus lies in the 
consideration of the relevant process variables within the working ranges. 

4.12.1 Integration of APG 

1. The integration of APG is configured in two phases: 

2. Insertion and configuration of APG blocks in the measuring points (AS) 

3. Placement and interconnection of APG objects (OS) 

 

NOTE You can find basic information about APG, for extension of an existing PCS 7 
project with APG and for configuration purposes in the application description 
"Integration of Advanced Process Graphics in SIMATIC PCS 7" under: 
https://support.industry.siemens.com/cs/ww/de/view/89332241. 

 

4.12.2 APG measuring points (AS) 

Two different range representations (ViewMode) are set in the project. The bar 
graphs in the Level 2 process picture show the process value in the differential 
representation, while in the Level 1 process picture, the bar graphs show the value 
in the absolute representation.  

Controller measuring points 

All controller measuring points of the polymerization reactor contain an instance of 
the APG connector block in "Sheet 4" of the chart partition "A" and are all 
interconnected and parameterized as follows: 

Connection Value Usage 

BockType 2 Representation suitable for the "PIDConL" block 

ViewMode 1 Absolute representation (value range) 

ViewRange 4 Display of the working range 

ReadPointer  Connected with "C.Status2" 

 

The following values are configured for the boundaries of the HMI instances: 

Measuring point Connection Value Usage 

FIC_Catalyst PV_OH_Li 40.0 Upper limit of the working range 

FIC_Catalyst PV_OL_Li 15.0 Lower limit of the working range 

FIC_Cocatalyst PV_OH_Li 2.5 Upper limit of the working range 

FIC_Cocatalyst PV_OL_Li 0.0 Lower limit of the working range 

FIC_Hydrogen PV_OH_Li 35.0 Upper limit of the working range 

FIC_Hydrogen PV_OL_Li 15.0 Lower limit of the working range 

FIC_Comonomer PV_OH_Li 200.0 Upper limit of the working range 

FIC_Comonomer PV_OL_Li 100.0 Lower limit of the working range 

FIC_Monomer PV_OH_Li 6300.0 Upper limit of the working range 

FIC_Monomer PV_OL_Li 5700.0 Lower limit of the working range 

FFIC_Diluent PV_OH_Li 48.0 Upper limit of the working range 

https://support.industry.siemens.com/cs/ww/de/view/89332241
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Measuring point Connection Value Usage 

FFIC_Diluent PV_OL_Li 15.0 Lower limit of the working range 

LIC_Reactor PV_OH_Li 80.0 Upper limit of the working range 

LIC_Reactor PV_OL_Li 45.0 Lower limit of the working range 

PIC_Reactor PV_OH_Li 9.0 Upper limit of the working range 

PIC_Reactor PV_OL_Li 6.0 Lower limit of the working range 

TIC_Polymer PV_OH_Li 90.0 Upper limit of the working range 

TIC_Polymer PV_OL_Li 80.0 Lower limit of the working range 

FIC_ServMedium PV_OH_Li 110.0 Upper limit of the working range 

FIC_ServMedium PV_OL_Li 70.0 Lower limit of the working range 

TIC_Jacket PV_OH_Li 22.0 Upper limit of the working range 

TIC_Jacket PV_OL_Li 18.0 Lower limit of the working range 

 

Display measuring point 

All display measuring points "QI_xxxxxx" contain two instances of the APG 
connector block in "Sheet 4" of chart partition "A", the instance "APG_Connect" for 
the absolute representation of the process value and the instance 
"APG_Connect_2" for the differential representation. The measuring points are 
interconnected and parametrized as follows: 

Module Connection Value Usage 

APG_Connect 
APG_Connect_2 BockType 1 

Representation suitable for the "PIDConL" 
block 

APG_Connect ViewMode 1 Absolute representation (value range) 

APG_Connect_2 ViewMode 2 Differential representation (value range) 

APG_Connect 
APG_Connect_2 ViewRange 4 Display of the working range 

APG_Connect 
APG_Connect_2 ReadPointer  Connected with "C.Status2" 

 

The following values are configured in the same way for each measuring point of 
the boundaries of the "APG_Connect" and "APG_Connect_2" instances: 

Measuring point Connection Value Usage 

QI_MFI PV_OH_Li 2.5 Upper limit of the working range 

QI_MFI PV_OL_Li 1.0 Lower limit of the working range 

QI_C2fraction PV_OH_Li 68.5 Upper limit of the working range 

QI_C2fraction PV_OL_Li 60.0 Lower limit of the working range 

QI_C4fraction PV_OH_Li 1.8 Upper limit of the working range 

QI_C4fraction PV_OL_Li 1.0 Lower limit of the working range 

QI_H2fraction PV_OH_Li 29.0 Upper limit of the working range 

QI_H2fraction PV_OL_Li 24.0 Lower limit of the working range 

QI_Density PV_OH_Li 950.0 Upper limit of the working range 

QI_Density PV_OL_Li 940.0 Lower limit of the working range 
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KPI measuring point 

The measuring point "KPI" contains three instances of the APG connector block to 
display the process parameters. The measuring point is interconnected and 
parametrized as follows: 

Module Connection Value Usage 

HMI_ResTime 
BockType 1 

Representation suitable for the "MonAnL" 
block 

HMI_ResTime ViewMode 1 Absolute representation (value range) 

HMI_ResTime ViewRange 4 Display of the working range 

HMI_ResTime ReadPointer  Connected with "ResidenceTime.Status2" 

HMI_ResTime DispRatio 0.6 Ratio of display to ViewRange  

HMI_ResTime PV_OH_Li 0.6 Upper limit of the working range 

HMI_ResTime PV_OL_Li 0.01 Lower limit of the working range 

HMI_STY 
BockType 1 

Representation suitable for the "MonAnL" 
block 

HMI_STY ViewMode 1 Absolute representation (value range) 

HMI_STY ViewRange 4 Display of the working range 

HMI_STY ReadPointer  Connected with "SpaceTimeYield.Status2" 

HMI_STY DispRatio 0.6 Ratio of display to ViewRange  

HMI_STY PV_OH_Li 180.0 Upper limit of the working range 

HMI_STY PV_OL_Li 100.0 Lower limit of the working range 

HMI_CatProduct 
BockType 1 

Representation suitable for the "MonAnL" 
block 

HMI_CatProduct ViewMode 1 Absolute representation (value range) 

HMI_CatProduct ViewRange 4 Display of the working range 

HMI_CatProduct ReadPointer  Connected with "CatProductivity.Status2" 

HMI_CatProduct DispRatio 0.6 Ratio of display to ViewRange  

HMI_CatProduct PV_OH_Li 400.0 Upper limit of the working range 

HMI_CatProduct PV_OL_Li 300.0 Lower limit of the working range 
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4.12.3 APG objects (OS) 

In order to provide the operator with an optimum working environment, the 
following two process pictures were created: 

 Level 1 process picture for orientation and navigation (system overview) 

 Level 2 process picture for operator control and monitoring of a device, in this 
case, the polymerization reactor 

 

NOTE You can find detailed information and the procedure for configuring APG in the 
Siemens Industry Online Support in the article "Integration of Advanced Process 
Graphics in SIMATIC PCS 7" under 
https://support.industry.siemens.com/cs/ww/en/view/89332241. 

 

Level 1 process picture (orientation and navigation) 

A process picture with a compressed representation of the main driving parameters 
is available for the monitoring of the process-related parameters of the overall 
system. This allows the overall context to be quickly detected and impressed as a 
pattern.  

 

 

https://support.industry.siemens.com/cs/ww/en/view/89332241
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Level 2 process picture (operator control and monitoring) 

Another process picture is available for the monitoring of the process-related 
parameters of the reactor and also for operator control, which schematically 
represents the most important process values and control of the reactor. This 
representation has the advantage that large volumes of data can be combined to 
form a compressed and clear display of information. 
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4.13 Smart Alarm Hiding 

With the Smart Alarm Hiding, alarms of a measuring point can be filtered or hidden 
depending on the plant state. This means that the filtered and hidden alarm 
messages of the measuring points are also sent to the alarm system where they 
are processed and archived. 

A reduction in the message traffic is thus achieved in process mode, which 
simplifies the operation of a system. 

 

Smart Alarm Hiding in the example project 

The following sequence has been followed for the configuration of Smart Alarm 
Hiding. 

Incl. compile CFC

and download the AS 

Step 1: Configuration of operating states

Step 2: Configuration of status block

Step 3: Configuration of the block group

Step 4: Configuration of the hiding matrix

Incl. Download OS  

and restart OS
Step 5: Compiling the OS

 

Note Further information on Smart Alarm Hiding can be found at the following link: 
https://support.industry.siemens.com/cs/ww/en/view/55699984. 

https://support.industry.siemens.com/cs/ww/en/view/55699984
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Step 1: 

The operating states are configured (1) in the master data library and synchronized 
in the multiproject (2) as follows. The created enumeration is called "Operating 
State". 

1

2

 

Step 2: 

The "STRep" status block is configured and the "State" inputs correspond to the 
operating states created in step 1. 
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Note In the project, the plant state is selected via the step sequencers. A direct 
interconnection of upstream blocks is also possible, however only one position 
(SFC or upstream block) can be activated at any time. 

 

The enumeration "Operating State" is assigned in the object properties of the 
output "QSTATE". 

 

 

The block group "PLANT" is predefined in the block properties. 
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Step 3: 

The technological blocks are assigned to the "PLANT" block group.  

 

 

The following technological blocks belong to the "PLANT" block group: 

 

 

Note The block group defines which technological elements belong together. It is 
recommended to define the block group at the unit level. 
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Step 4: 

The Hiding Matrix has been configured for the following plant states: 

 Plant state Activation via  suppressed messages 

1.  Operation End of sequencer 
STARTUP 

None 

2.  Out_of_Operation End of sequencer 
SHUTDOWN 

All messages and alarms 

3.  Startup Start of sequencer 
STARTUP 

Lower limit values of the filling level, 
flow, pressure and temperature 
measurement and KPI  

4.  Shutdown Start of sequencer 
SHUTDOWN 

Lower limit values of the filling level, 
flow, pressure and temperature 
measurement and KPI 

5.  Product_change n. A.  

6.  Standby n. A.  

7.  Emergency n. A.  

8.  Maintenance n. A.  

 

Operation

Startup Shutdown

Out of 

Operation

P
R

EP
A

R
IN

G

SHUTDOWN

 

 

Step 5: 

The OS in the project has already been compiled and prepared for operation. 
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5 Useful information  

5.1 Piping and instrumentation diagram 

The following figure shows the individual elements of the polymerization reactor in 
a piping and instrumentation diagram. 
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5.2 Polymerization 

Polymerization is a chemical reaction in which the same or different molecules 
(also called monomers) combine to form a chain, the so called polymers. The 
reaction is initiated by radicals. The unsaturated monomers attach themselves to 
the chain until it has reached the desired length and possibly also network. The 
catalysts used are mostly correspondingly targeted at the reaction control. 

The following educts are typically used for the production of polymers: Monomers 
(in the example of ethane: C2), comonomers (in the example of butane: C4), 
hydrogen (H2 all gaseous) as well as the catalyst and cocatalyst (solids). 

 

Synthetic polymers based on carbon: 

 Polyethylene (PE) 

 Polypropylene (PP) 

 Polyketone (PK) 

 Polyvinyl chloride (PVC) 

 

Synthetic polymers with other bases: 

 Silicones, particularly poly(organo)siloxanes 

 Melamine resin 

 

Biopolymers: 

 Proteins such as enzymes, hair, silk,  

 DNA (the genetic material) 

 RNA 

 Carbohydrates such as cellulose, wood, paper, starch, chitin 

 Polyhydroxyalkanoates, the biopolyester as an energy and carbon storage of 
bacteria 

5.3 Melt flow index (MFI, MFR) 

The melt flow index (MFI = Melt Flow Index, or MFR = Melt Flow Rate ) describes  
the fluidity (viscosity) of a material/materials, such as polymer melt and is 
expressed in weight per 10 minutes (g/10 min). This flow behavior applies to 
certain pressure and temperature conditions. The melt flow index is related to the 
length of the polymer chains and is thus indirectly a measure for other polymer 
properties such as density and hardness. 

A fixed MFI of the finished good is usually preset as a specification for a particular 
polymer. Excessive deviation means an insufficient quality. 

Alternatively, it is also possible to define a melt volume-flow rate (MVR = Melt 
Volume Rate, MVI = Melt Volume Index). This is expressed in volume per 10 
minutes (cm³/10 min). 
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5.4 Project structure 

5.4.1 CFC structure 

A uniform naming convention is used for identifying the measurement points, 
whereby the function has been named according to the European standard EN 
62424. The following figure shows the composition of a measurement point name: 

TIC_Jacket

Function

T = temperature (first letter)

I = indication (subsequent letter)

C = control (subsequent letter)

Designation

 

 

The following table contains all letters used in the application their meanings: 

First letter Meaning 

F Flow 

L Level 

M Moisture 

N Motor 

P Pressure 

Q Amount, quantity or quality 

C Speed (velocity, rotational speed, frequency) 

T Temperature 

X Freely selectable first letter 

Y Control valve 

 

Subsequent 
letter 

Meaning 

C Control 

F Fraction 

I Indication 

S Binary control function or switching function (not safety-oriented) 
("switching") 

 

5.4.2 Plant view 

The unit template "Polymerization Reactor" is implemented in the plant view in two 
hierarchy levels. 

In the AS project, the first hierarchy level is empty and in the subordinate hierarchy 
level there is only respectively one hierarchy folder, with the necessary CFC charts 
and the associated process simulation ("Sim_*" charts), for each technical function 
(functional unit) of the polymerization reactor. The simulation can be removed for 
use in a real plant. 

The first hierarchy level of the OS project includes the plant overview and the 
process image. The process picture "PolyReactor.pdl" of the polymerization reactor 
is located in the subordinate hierarchy folder.  
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The following figure depicts the PCS 7 multiproject structure. 
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6 Appendix 

6.1 Service and support 

Industry Online Support 

Do you have any questions or need assistance?  

Siemens Industry Online Support offers round the clock access to our entire 
service and support know-how and portfolio. 

The Industry Online Support is the central address for information about our 
products, solutions and services.  

Product information, manuals, downloads, FAQs, application examples and videos 
– all information is accessible with just a few mouse clicks: 
https://support.industry.siemens.com 
 

Technical Support 

The Technical Support of Siemens Industry provides you fast and competent 
support regarding all technical queries with numerous tailor-made offers  
– ranging from basic support to individual support contracts. Please send queries 
to Technical Support via Web form: 
www.siemens.com/industry/supportrequest 
 

SITRAIN – Training for Industry  

We support you with our globally available training courses for industry with 
practical experience, innovative learning methods and a concept that’s tailored to 
the customer’s specific needs. 

For more information on our offered trainings and courses, as well as their 
locations and dates, refer to our web page: 
www.siemens.com/sitrain  
 

Service offer 

Our range of services includes the following:  

 Plant data services 

 Spare parts services 

 Repair services 

 On-site and maintenance services 

 Retrofitting and modernization services 

 Service programs and contracts 

You can find detailed information on our range of services in the service catalog 
web page: 
https://support.industry.siemens.com/cs/sc 
 

Industry Online Support app 

You will receive optimum support wherever you are with the "Siemens Industry 
Online Support" app. The app is available for Apple iOS, Android and Windows 
Phone:  
https://support.industry.siemens.com/cs/ww/en/sc/2067 

https://support.industry.siemens.com/
http://www.siemens.com/industry/supportrequest
http://www.siemens.com/sitrain
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/en/sc/2067
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6.2 Links and literature 

No. Topic 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link to this entry page of this application example 

https://support.industry.siemens.com/cs/ww/en/view/84061788 

\3\ SIMATIC PCS 7 overview (collection of links for FAQ, manuals, compendium, 
forum, application examples and videos) 

https://support.industry.siemens.com/cs/ww/en/view/63481413 

\4\ Controller optimization with the PID Tuner 

https://support.industry.siemens.com/cs/ww/en/view/8031495 

\5\ Equipment Modules for PCS 7 using the example of the Chemical Industry 

https://support.industry.siemens.com/cs/ww/en/view/53843373 

\6\ PCS 7 Unit Template "Stirred Tank Reactor" using the example of the Chemical 
industry 

https://support.industry.siemens.com/cs/ww/en/view/60546560 

\7\ PCS 7 Unit Template "Fermenter" using the example of the Chemical Industry 

https://support.industry.siemens.com/cs/ww/en/view/68098270 

\8\ PCS 7 Unit Template "Distillation Column" using the example of the Chemical 
Industry 

https://support.industry.siemens.com/cs/ww/en/view/48418663 

\9\ PCS 7 Unit Template "Dryer" using the example of the Chemical Industry 

https://support.industry.siemens.com/cs/ww/en/view/74747848 

\10\ How do you procure documentation for PCS 7 (including the PCS 7 Manual 
Collection)? 

https://support.industry.siemens.com/cs/ww/en/view/59538371 

\11\ Integration of Advanced Process Graphics in SIMATIC PCS 7 

https://support.industry.siemens.com/cs/ww/en/view/8933224 

\12\ Practical manual for controllers with SIMATIC S7 and SIMATIC PCS7 for process 
automation 
Müller, Jürgen / Pfeiffer, Bernd-Markus / Wieser, Roland, Publicis 
Kommunikationsagentur ISBN 978-3895783401 

 

 

6.3 Change documentation 

Version Date Modifications 

V1.0 04/2014 First edition 

V1.1 05/2014 New chapter 4.12 and 2.4.4 added 

V1.2 09/2015 Update for PCS 7 V8.1 

V1.3 08/2018 Update for PCS 7 V9.0 SP1, Integration of Smart Alarm 
Hiding, Note on Managed System Services in Chapter 1.3 

 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/84061788
https://support.industry.siemens.com/cs/ww/en/view/63481413
https://support.industry.siemens.com/cs/ww/en/view/8031495
https://support.industry.siemens.com/cs/ww/en/view/53843373
https://support.industry.siemens.com/cs/ww/en/view/60546560
https://support.industry.siemens.com/cs/ww/en/view/68098270
https://support.industry.siemens.com/cs/ww/en/view/48418663
https://support.industry.siemens.com/cs/ww/en/view/74747848
https://support.industry.siemens.com/cs/ww/en/view/59538371
https://support.industry.siemens.com/cs/ww/en/view/8933224
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